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About this Guide

1.1 About the MILL Module

The VisualCAM 2015 for Geomagic MILL module offers fast gouge free solids/surface model
machining technology coupled with cutting simulation/verification capabilities for programming
CNC Mills, running inside Geomagic. This integration allows for seamless generation of
toolpath and cut material simulation/verification inside Geomagic, for programming milling
machines that support 3 and 4 axis continuous machining.  

The module also comes with numerous post-processors to output the programmed G-code
to some of the most popular machines in the market.  A simple and well thought out user
interface makes this system one of the most intuitive and easy to use milling systems in the
market.

You can work with the native Geomagic data as well as use any of the data types that can be
imported into Geomagic such as solids, surfaces and meshes. Then you can use the
VisualCAM 2015 for Geomagic MILL module with its wide selection of tools and toolpath
strategies to create machining operations and associated toolpaths for CNC Mills. These
toolpaths can then be simulated and verified, and finally post-processed to the controller of
your choice.

VisualCAM for Geomagic MILL Module Quick Started Guide

1.2 Using this Guide

If you have installed VisualCAM 2015 for Geomagic successfully on your computer and are
now looking at the blank screen of Geomagic and wondering what to do next, this is the guide
for you.  This guide will explain how to get started in using the VisualCAM 2015 for Geomagic
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MILL module to program a simple part through an example.  

This guide will illustrate machining of a simple prismatic part such as this gasket using 2-1/2
milling operations. Even though we have created a 3D representation of the gasket, it will
become apparent as we go that we can machine this using just 2D curves.  The reason we
are able to do this is because of the prismatic nature of this model, which means that the
curves can be treated as the edges of vertical walls in the geometry. 

This guide has two associated Geomagic files that you can find located in the QuickStart
folder under the installation folder of this guide. The first file is a completed file that contains all
of the completed toolpaths and machining operations and represents the file that you should
end up with after working through the tutorial. The other file is a starter file that contains only
the geometry. Use the completed file as a reference. Copy the starter file and use this file to
begin each tutorial.

MILLQuickStartTutorial.AD_PRT

1.3 Useful Tips

Here are some useful tips that will help you use this guide effectively.

1. Copy the tutorial part files in a location other than the installation folder to make sure
you have read/write privileges to the files. 

2. Once you start working with the tutorial file, save your work periodically!

3. Don’t stress out too much if you are having trouble with the tutorial.  Call us or send us
email and we can help you out.

4. Most of all have fun!
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Getting Ready

2.1 The VisualCAM 2015 for Geomagic Security Key

In order for VisualCAM 2015 for Geomagic to function fully it requires a security device, called
a hardware key or a dongle. 

Without the security device, VisualCAM 2015 for Geomagic will operate only in Demo mode. 
When VisualCAM 2015 for Geomagic is operating in demo mode you will still be able to run
VisualCAM 2015 for Geomagic but will not be able to do the following:

Save CAM data to Geomagic files

Post-process created tool paths

In order for VisualCAM 2015 for Geomagic to operate fully the security key needs to be
properly installed on your computer or network.  Please follow the instructions that came with
your installation program on how to do this.

2.2 Running VisualCAM 2015 for Geomagic

Locate the Geomagic Design shortcut on your desktop and double click to launch the
application.   

Alternatively you can also click on the Windows Start button and select All Programs.  Go to
the program group containing Geomagic Design. (The name of this program group will
usually be called Geomagic Design, unless you specified otherwise during setup.)

Once you locate the program group, select it and then select Geomagic Design to launch the
application.

If the installation was successful, upon launching of Geomagic Design and opening a Part
document you should observe a ribbon bar entry called VisualCAM 2015 in the Add-ons tab of
the Geomagic Design ribbon bar.

If you do not see this menu entry then please check the On Line Help document of the
product (found in the installation folder) for help with trouble shooting the installation.

VisualCAM 2015 for Geomagic only operates in the Part mode of Geomagic.  If
you are running in the Drawing or Assembly mode of Geomagic you will not
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see VisualCAM's menu bar loaded in the Geomagic ribbon bar.

2.3 Machining Strategy

Based on the type of geometry of this part, we will machine this model out of a 10 x 6 x 1/8
inch poplar wood sheet.  Since the part is relatively thin and prismatic, we will machine this
out by using only a single type of machining operation - 2-½ axis machining method called 
Profiling.  We will also use just a single 0.5 inch flat end mill for performing all machining.  We
will also assume that the wooden sheet will be held to the machine table or the spoil sheet on
the table using double-sided tape or a vacuum table requiring no clamps or fixtures.

2.4 Main Programming Steps

The following steps will be followed in machining this model.  Some of these steps will have to
be performed just once and others may have to be repeated to complete the machining.

1. Define the Machine and Post-processor to use.  

2. Define the Machining Setup including Stock Geometry, Material and Work Zero.  

3. Create and Select a Tool to use for machining.  

4. Create the Machining Operations including the Feeds and Speeds, the Clearance
Plane and other Cutting Parameters.  

5. Generate the toolpaths.  

6. Simulate the toolpaths.  

7. Post Process the toolpaths.  

8. Generate Shop documentation.  

2.5 Loading the Part Model

The Part typically is the geometry that represents the final manufactured product.   

1. Select File / Open from the Menu, or click the Open icon from the Standard bar.

2. From the Open dialog box, select the MILLQuickStartTutorial.ad_prt file from the C:
\ProgramData\MecSoft Corporation\VisualCAM 2015 for Geomagic\QuickStart\ folder.
 As mentioned before, it is advisable to make a copy of this part at a suitable



VisualCAM© 2015 for Geomagic MILL Quick Start8

© 2015 MecSoft Corporation

alternative folder so that you have write privileges to modify the part.

By default, the ProgramData folder is "hidden" from view.  Here are the
steps to Show hidden files and folders:

1. For Windows7/8 users: Go to Control Panel > Appearance and
Personalization > Folder Options (Windows XP users can locate folder
options under Control Panel).

2. Select View tab and under advanced settings select Show Hidden files and
folders, clear the check boxes for:

Hide extensions for known file types  

Hide protected operating system files (Recommended)  

3. Click Apply and OK.

The part appears as shown below
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MILLQuickStartTutorial.SLDPRT

You can import 2D drawings, Solid, Surface and Mesh models that are
supported in Geomagic.

2. The VisualCAM 2015 menu item is added to the Add-Ons ribbon bar in Geomagic
Design.
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2.6 Launching the MILL Module

Follow the procedure below to launch the VisualCAM 2015 for Geomagic TURN module:

1. Select MILL from the VisualCAM 2015 menu located on the Add-Ons ribbon bar in
Geomagic Design.

2. You will see two dialogs, one called the Machining Browser and the other called the
Machining Objects Browser displayed on a separate tab labeled VisualCAM 2015 next
to the Design Explorer tab
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The Machining Browser is also referred to as the Machining Operations Browser or
the MOps Browser.  The Machining Objects Browser is also referred to as the MObs
Browser.

3. You can also re-size the height and width of each browser making sure that all of the
command icons and menus are easily accessible.
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2.7 Define the Machine Tool

The first step in the machining process is to define the machine tool to use.  

1. From the Program tab from the Machining Browser select Machine.
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2. Under the Machine Tool Coordinate System tab, select the World Coordinate System
button to align the Machine Coordinate System (MCS) to the World Coordinate
System (WCS).

3. Now select the Machine Tool Definition tab and under Machine Type, set Number of
Axes to 3 Axis.

4. Click OK. The machine type now appears under Machining Job in the Machining
Browser.
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2.8 Select the Post Processor

Next, we'll define the Post Processor.

1. From the Program tab select Post to display the dialog.

2. For the Current Post Processor, select Haas from the list of available posts.  

3. Then set the Posted File Extension to .nc.  Other file extensions are available
depending on your machine requirements. 
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4. Pick OK and notice that the Post type now appears under Machining Job in the
Machining Browser.
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By default post processor files are located under:

C:\ProgramData\MecSoft Corporation\VisualCAM 2015 for Geomagic\Posts\MILL\

The program to send the posted output is set to notepad.
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The Setup

3.1 Define the Machining Setup - Skip this section if in Standard or
Expert Configuration

Now let's define the Machining Setup.  The Machining Setup allows you to orient the Machine
Coordinate System such that the part is aligned in the exactly same way as it would be
fixtured on the machine tool for cutting.

This functionality is available only in the Professional and Premium
configurations of the product. In the other configurations (Standard and

Expert) you will have to use the CAD tools to orient the part geometry so that it
is in the correct orientation for machining.

If there is no Setup1 listed under your Machining Job, the system automatically creates one
when a work zero or an operation is generated.

However, by default, the MCS (Machine Coordinate System) is already aligned with the WCS
(Word Coordinate System) so this step is not required for this part.

However, in production you can have multiple setups and assign different machining
orientations for each.

3.2 Create Stock Geometry

In this step we'll define the raw stock from which to cut the part.

1. From the Program Tab select Stock and then select Box Stock from the menu to
display the dialog.
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2. Under Dimensions, set the Length L to 10.0, Width W to 6.0 and Height H to 0.125.
Note that the stock dimensions you enter are measured from the corner of the
bounding box selected in this dialog.
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The dimensions of the stock are interpreted in relation to the corner selected in
the dialog box above.  For example if the corner of the box is selected as the 

Bottom South West corner (as shown in the picture above), the Length (L) is
interpreted to be along the +X axis, the Width (W) along the +Y axis and the Height
(H) along the +Z axis.  The direction of the dimensions will change depending on
the corner selected.  For example if the Top South West corner is selected, then
the Height (H) is interpreted to be along the –Z axis and so the stock will extend
below the corner.

3. Pick OK and notice that the Stock type now appears under Machining Job in the
Machining Browser.

4. If the stock does not display on the screen, select the Stock Visibility icon located at
the base of the Machining Browser.
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3.3 Align Part and Stock

Once the stock model is created you can move it in alignment with the part if needed.

1. From the Program Tab select Align and then Align Stock from the menu to display the
dialog.

2. For Z Alignment select Top and for XY Alignment select Center and then pick OK.
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The stock is now aligned to the center of the part in XY and the Top of the part in Z.
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3.4 Specify Material

Next, we'll set the material for the stock geometry.

1. From the Program Tab select Material to display the dialog box.

2. For Material, select Wood from the list of available materials and then pick OK.
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The material texture is now assigned to the Stock geometry.  The texture is applied
when the stock model is displayed in the Simulation window.

Note: VisualCAM 2015 for Geomagic uses a separate simulation window to
perform and render the cut material simulation.  To bring up this window,

select the Simulation tab from the Machining Browser and select the Window
icon as shown below:
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3. If the material texture does not display on the stock, select the Material Texture
Visibility icon located at the base of the Machining Browser.

4. Now select the Simulation Window icon  again to close the Simulation
Window. 
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3.5 Set Work Zero

Now that the stock is aligned to the part geometry, in this step, we will establish the work
coordinate origin also referred to as the Work Zero.  The Work Zero translates the MCS origin
from the Setup to the desired location. This can be set to any location on the part or stock
geometry.

The Work Zero defines the zero point with respect to which all toolpath
points are interpreted by the controller.  This would normally be the same

as the tool touch off point on the actual work-piece on your machine.  So care
should be taken to make sure that this Work Zero point defined in
VisualCAMWork Zero matches the tool zero point used on the actual work
piece located on the table of your machine.

1. Select Work Zero from the Program tab of the Machining Browser to display the Work
Zero dialog.

2. Select Set to Stock Box and then set Zero Face to Highest Z, Zero Position to South
West corner and then pick Generate. This sets the machine home to the top of the
stock material and the southwest corner of the stock geometry.
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3. The Work Zero is now translated to the Southwest corner and top of stock material.
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4. Also, the Work Zero now appears under the Machining Job in the Machining Browser.
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Create Tools

To machine the above part we will now create a ½ inch (0.5”) Flat End Mill.

1. Select the Tools tab under Machining Objects Browser and click Create/Edit Tools.

2. Select the Tool Type to Flat Mill.

3. Set tool Name as FlatMill-0.5, Tool Diameter = 0.5. Under the Properties tab set
Material to HSS and Tool Number = 1.

4. Switch to Feeds and Speeds tab and click Load from File.
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5. Set Stock Material to Wood and Tool Material to HSS.
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6. Click OK and the computed cut feedrate and spindle speed are transferred to the
Feeds and Speeds tab of the tool dialog.

7. Click Save as New Tool to save the tool. The tool is now created and listed under
Tools in Session on the left side of the Create/Select Tool dialog. Click OK to close
the dialog.



Create Tools 31

© 2015 MecSoft Corporation

You can edit the tool properties and click Save Edits to Tool to save the
changes. You can create additional tools by assigning a different name and

specify the tool parameters.

The created tool is now listed under Tools tab in Machining Objects browser.

To save Tools to a library, Click Save Tool library under the Tools tab in
the Machining Objects Browser and specify a folder location and file name

in the Save as dialog box. Saving a Tool library as a Knowledge base file (*.vkb)
saves feeds and speeds with tool properties.
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Create Machining Operations

Now we're ready to create our first Profiling operation.

1. From the Program Tab select 2 Axis and then Profiling from the menu of 2 Axis
operations.

This will display the 2 ½ Axis Profiling operations dialog.  We will go over the steps for
creating the profile operations for the inner features of the Gasket.
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5.1 Select Machining Features/Regions

1. Under the Control Geometry tab pick Select Drive /Containment Regions.
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The Profiling operation dialog is now minimized and allows selection of features to
machine. We will now select the surface edges of the 3 inside hole features.

2. While pressing the <Shift> key, select the first hole by clicking near the upper surface
edge as shown below.
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3. Now, while the <Shift> key is still pressed, select the edges of the two remaining
holes.

4. Now select the  icon to complete the selection.

5. The 2 ½ Axis Profiling dialog comes back up displaying the selected Drive Regions. 
They are also highlighted on the part.

6. Notice that selecting a Drive Region from the list highlights the corresponding surface
edge curve on the part.
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5.2 Select Cutting Tool

Now we'll set the Tool for our operation:

1. Now we switch to the Tool tab of the dialog.

2. Select Flat Mill-0.5 under Tools. The 0.5" Flat End Mill is now selected as the active
tool. 
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Note that the Tool parameters of the currently active tool are always displayed in the
status bar at the bottom of the Machining Objects Browser.

5.3 Set Feeds and Speeds

Now we'll set the Speeds and Feeds for our operation:

1. Switch to the Feeds & Speeds tab of the 2 ½ Axis Profiling dialog.

2. Select the Load from Tool button. VisualCAM 2015 for Geomagic will retrieve the feeds
and speeds parameters that were set when the tool was defined and associate them
with the current operation.
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5.4 Clearance Plane

Now we'll set the Clearance geometry for our operation:

1. We'll switch to the Clearance Plane tab of the 2 ½ Axis Profiling dialog.

2. Set the Clearance Plane Definition to Automatic and Cut Transfer Method to
Clearance Plane.
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In the Automatic mode, VisualCAM 2015 for Geomagic will determine a safe Z height
for locating the clearance plane. Setting the Cut Transfer Method to Clearance Plane
will force all transfer moves to be performed in this determined clearance plane.

When this tab of the dialog is active, the clearance plane is shown on the graphics
screen.
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5.5 Specify Cut Parameters

Now we'll set the Cut Parameters for our operation:

1. Switch to the Cut Parameters tab of the 2 ½ Axis Profiling dialog to control the cutting.

2. Set the Stock = 0.  This means that we will not be leaving any thickness on the part
after machining.  

3. Under the Cut Start Side section check the box next to Use Outside/Inside for Closed
Curves and then select Inside.
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Alternately you could use the Determine using 3D Model option.  In this case
VisualCAM 2015 for Geomagic would use the 3D model to determine which side of the
curve to place the cutter for machining.

5.6 Cut Levels

Now we'll set the Cut Level for our operation:

1. Select the Cut Levels tab tab of the 2 ½ Axis Profiling dialog.

2. Set Location of Cut Geometry to At Top. 

3. For Total Cut Depth, enter 0.125.  The cut depth is always set as an absolute value. 

4. This automatically sets the Rough Depth and Rough Depth/Cut to 0.125.
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5.7 Entry/Exit Parameters

Next we'll set Entry and Exit parameters for our operation:

1. Next, we elect the Entry/Exit tab.

2. Entry/Exit parameters control how the cutter will engage material as it begins cutting
and how it leaves the material as it completes cutting. 

3. Set Entry Motions and Exit Motions to None.

4. Now pick Generate. 
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5. The 2½ Axis Profile toolpath is generated and the operation is listed under Setup 1 in
the Machining Browser. 
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6. The toolpath is also displayed in the graphics screen.

7. Note that the display of the toolpath in the graphics screen can be turned on/off by
selecting the Toolpath Visibility icon located at the base of the Machining Browser.
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5.8 Simulate Toolpath

The new toolpath can now be Simulated to display the in-process stock model.

1. Switch to the Simulate tab at the top of the Machining Browser.

2. Under Preferences, uncheck Simulate by Moves and adjust the slider to the left to
slow down the simulation speed.

3. Select the 2 1/2 Axis Profiling operation we just created, select the Simulation Window

icon  and then pick Play to start the simulation.
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4. You can stop the simulation at anytime by selecting the Pause button in the simulation
ribbon bar.  Subsequent to pausing the simulation, you can either choose to continue
the simulation by selecting the Play button again or exit the simulation by selecting the
Stop button.

5. To view the cut model with textures applied, select the Material Texture Visibility icon
located at the base of the Machining Browser.
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Now select the Simulation Window icon  again to close the Simulation
Window.
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Machining the Outer Area

Now we will turn our attention to machining the outer profile of the part.  Again, we will create a
simple profile toolpath, this time around the outer periphery of the part.

1. Switch to Program tab in the Machining Browser.

2. Select the 2 ½ Axis Profiling operation we just created. 

3. Right-click on the selected operation and select Copy. 

4. Now Right-click again and select Paste. 
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5. This creates a copy of the operation and places it below the original in the Machining
Browser.
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6. Now right-click on the second operation and pick Edit to adjust its parameters.

7. Pick Remove All under the Control Geometry tab.

8. Pick Select Drive/Containment Regions.

9. While pressing the <Shift> key, select the top outer surface edge and then select the

 icon to complete the selection.  Note: This edge has eight (8) separate segments
so be sure to select all of them as shown in the dialog below.
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10. Switch to the Cut Parameters tab and change the Cut Start Side to Outside.

11. We'll accept all of the remaining parameters and pick Generate.

12. The new 2 ½ Profiling toolpath is generated and displayed on the graphics screen.
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13. Now we'll select the new 2 ½ Axis Profiling operation we just created, select the

Simulation tab, select the Simulation Window icon  and then pick Play.

Now select the Simulation Window icon  again to close the Simulation
Window.
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Post Processing

Now with the toolpaths complete we're ready to post-process to an output text file containing
G-codes that can then be sent to the machine tool to actually machine the part.

1. Select Setup 1 from the Machining Browser, right-click and select Post.  This will post-
process all operations created under the Setup.

2. By default, the Part file name and the Setup name are appended for the G-code file
name.  Also by default, the posted G-code file is saved to the folder where the part file
is located.  

The output file names can be controlled by setting the Posted File Naming
Conventions sections of the Set Post-Processor Options dialog.  Refer to the

Select the Post Processor step for displaying this dialog.
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The post by default is set to Haas as specified under the Post processor
setup. You can change the post processor by selecting a different one

from the drop down menu in the list. The posted G-code by default will be saved
to the folder where the part file is located.

3. Now pick Post and the G-code file is displayed in Notepad where it can be viewed or
edited manually. 
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4. Now close Notepad.
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Generating Reports

At any time, you can create a Report of your Machining Operations. 

1. Switch to Program tab in the Machining Browser.

2. Select Setup 1.

3. Right-click and select Information to display and Print the report.
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This dialog provides an estimate of the machining time required for the operations in
the Setup.

You can perform the same right-click sequence on the Machining Job to determine the
estimated machining time for all Setups. 

4. Now pick OK to close the Information dialog.

8.1 Generating Shop Documentation

You can also create a Setup Sheet by generating a Shop Document. This is typically used to
instruct machine operators on how to setup and machine the part on the CNC machine.

1. Select Setup1.

2. Right-click and select Shop Documentation.
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3. Select Template1 and click Save.
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4. This creates an HTML based Shop Document that can be viewed in a web browser. 
You can select from one of the 2 HTML templates that are shipped with the product
and generate shop documentation. Once you have selected the template, a shop
documentation html file will be created and saved.  This file can then be printed and/or
viewed in a web browser such as Internet Explorer. 
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5. You can perform the same right-click sequence on the Machining Job to generate
Shop Documentation for all Setups.
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Where to go for more help

We have come to the end of the Quick Start Guide of theVisualCAM 2015 for Geomagic MILL
module.  

If you need additional help please use the following resources:

The on-line help distributed with the product is a great resource to find reference
information on the various functions available

Apart from the on-line help system you can download other tutorials and projects from 
MecSoft Corporation's web site at www.mecsoft.com. This will help you get started
with using VisualCAM 2015 for Geomagic .

If you need additional help, or if you have any questions regarding VisualCAM 2015 for
Geomagic, you may contact us via e-mail at support@mecsoft.com

MecSoft offers Online training as well as personalized full day training sessions.
Please look up our website or email us at sales@mecsoft.com for further details

Please do continue to visit our home page to learn about the latest updates to 
VisualCAM 2015 for Geomagic and any other help material.

http://www.mecsoft.com
mailto:support@mecsoft.com
mailto:sales@mecsoft.com
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